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The MathType Window 
The picture below shows MathType with all parts of its toolbar visible: 

 Ruler

 Symbol palettes

 Template palettes

 Small tabbed bar

 Small bar

 Palette

 Tabs

 Large tabbed bar

 Insertion point

 Selection

 Status bar

 Empty slot

 H
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Within the equation area itself, there are four items of interest:  

Empty Slot 
A slot containing no text is displayed with a dotted outline. 

Insertion Point 
A blinking marker consisting of a horizontal line and a vertical line that indicates 
where text or templates will be inserted next. 

Selection 
The part of the equation that will be affected by any subsequent editing 
commands is highlighted. 

Status Bar 
The Status Bar contains four areas that tell you your current settings for Style, 
Size, Zoom, and Color. You can change these settings using menu commands or 
simply right-click on an area to show a menu for that setting. While moving the 
mouse in the toolbar or in the menus, the four Status Bar entries are temporarily 
replaced by a message that describes the item the mouse pointer is over. At other 
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to delete the selection. Pressing the ENTER key will start a new line below the 
original line. Immediately after typing, you can choose the Undo Typing 
command on the Edit menu to erase everything that you typed since the last 
non-typing operation. 

Why the Spacebar Doesn’t Work 
The SPACE key usually has no effect, since MathType performs spacing of 
mathematical equations automatically. Professional-quality mathematical 
formatting involves six different space widths, none of which is the same width 
as the space character in most fonts, so it would be undesirable to insert the 
standard space character into your equations. Many people find this a bit 
confusing at first, but you will get used to it quickly. However, sometimes you 
might want to insert a non-mathematical phrase into your equations and, here, 
the standard space is exactly what you want. To do this, just change the current 
style to Text and start typing. See Tutorial 4 in Chapter 4 for details. 

Sometimes you may find it necessary to override MathType’s automatic spacing. 
There are CTRL (Control) key shortcuts for entering various widths of space; for 
instance, CTRL+SPACE inserts a thin space. See Tutorial 6 in Chapter 4 for more 
information. 

Inserting Symbols 
Keyboard Shortcuts 
MathType also provides 
keyboard shortcuts for 
inserting almost all 
symbols on the palettes. 
These are shown in the 
Status Bar when the 
mouse is over each 
symbol. You can also 
assign your own 
keyboard shortcut to any 
symbol. See Tutorial 16 
in Chapter 4 for more 
information. 

To insert a symbol, you click on it in one of the bars, or choose it from one of the 
Symbol Palettes, as shown in the picture below. The Symbol Palettes work like 
standard Windows menus — just press or click the left mouse button to display 
the palette’s contents, then choose the desired symbol. The symbol will be 
inserted immediately to the right of the insertion point or, if something is 
selected, the symbol will replace it. 
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Chapter 4 
Tutorials 

Before You Start 
This chapter contains several tutorial examples of using MathType. We provide 
step-by-step instructions for each example, so you should find it easy to work 
through them. Each tutorial should take you no more than 10 minutes, and they 
are by far the best way to learn MathType. Before you start, however, there are a 
few things to bear in mind. 

First, recall that you can find symbols and templates either in the palettes at the 
very top of the MathType window, or in the bars lower down. You have to pull 
down the palettes to find the items you need, but you can just click on the ones 
in the bars. For the most part, the tutorials will require very common symbols 
and templates that we placed in the bars for you before we shipped MathType. 
You can change the contents of these bars at any time; we explain how in 
Tutorial 5. 

Undo and Redo  
You can also correct 
mistakes by using the 
Undo command on 
MathType’s Edit menu. 
In MathType 5 you can 
Undo and Redo an 
unlimited number of 
times. 

Also, you do not have to worry about making mistakes. If you type something 
wrong, or choose the wrong symbol from one of the palettes, you can correct 
your mistake by pressing the BACKSPACE key. 

Fonts and the Appearance of Your Equations 
The tutorials will often tell you that “your equation should now look like this.” 
In fact, the appearance of your equation will be determined by the fonts you are 
using, so you shouldn’t take this statement too literally. MathType’s default fonts 
are Times New Roman, Symbol and MT Extra. These fonts will probably be 
acceptable, at least for the purposes of working through the tutorial, and we 
recommend that you stick with them until you’ve gained some experience 
working with MathType. 

For the time being, please do not change fonts by using the Other command on 
the Style menu — as you’ll see in Tutorial 8, there’s a much better way of doing 
this in MathType, and we don’t want you to get into any bad habits. 

Some Final Advice 
In the first few tutorial examples, we’re going to assume that you’re using 
MathType along with Microsoft Word to create a document. MathType works 
with a wide variety of word processing, publishing, Web editing and graphics 
programs, but Word is by far its most common companion. If you want to work 
through the tutorials using some other word processing application, it should be 
easy to adapt the instructions that follow. Also, detailed instructions for using 
MathType with other applications are available in Chapter 5. 
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In the tutorials, we’ll often tell you to type certain characters into your equations. 
The characters you have to type will be shown in bold type. 

Tutorial 1: Fractions and Square Roots 
In our first tutorial, we will create the equation 

 23
16 sin tany x c µ= − ± x  

This is a very simple equation, but you’ll learn about fractions and square root 
templates, and we’ll explore the properties of the insertion point, and illustrate 
MathType’s function recognition and automatic spacing capabilities. 

To create the equation, just follow the steps listed below. Remember that the 
characters you have to type into the equation are shown in bold type. 

1. Open a new Word document, and type a few lines of text, just to make the 
situation a bit more realistic. 

Word Toolbar 
You can insert a display 
equation using the  
button on Word’s 
MathType toolbar. You 
can see what each 
toolbar button does by 
holding the mouse 
pointer over the button 
for a couple of seconds. 
A tooltip will appear 
containing the name of 
the button’s command. 

2. Now we’re ready to insert a MathType equation. If you installed MathType 
correctly, there should be a MathType menu towards the right-hand end of the 
Word menu bar, as shown below. 

 

From the MathType menu choose the Insert Display Equation command. This 
will open a MathType window, ready for you to start creating the equation. If for 
some reason neither the MathType menu nor the MathType toolbar is available 
in Word, use Word’s Insert Object command (choose Object on the Insert menu), 
and choose MathType 5.0 Equation from the list of object types displayed. See 
Chapter 5 to learn about other ways to insert an equation, either in Word or 
other applications. 

3. In the MathType window, type y=. You don’t have to type a space between 
the y and the =, because MathType takes care of the spacing automatically. To 
help you break the habit of typing spaces, the spacebar is disabled most of the 
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time in MathType, so pressing it will have no effect (other than producing an 
annoying beep!). Chapter 7 discusses where and how you should enter spaces in 
MathType, but you won’t have to do this very often. 

Also, notice that the y has been made italic, but the = sign has not. Mathematical 
variables are almost always printed in italics, so this is the default in MathType. 
You can change this by redefining the Variable style using the Define command 
on MathType’s Style menu. See Chapter 7 for details. 

4. Now we need to enter a square root sign. To do this, click on the  icon in 
the Small Bar. The  template’s home is in the  palette, but we’ve also 
moved it into the Small Bar to make it easier for you to find. Your equation 
should now look like this: 

  

The characters in the equation might be larger than you expect, but this is just a 
result of the viewing scale you’re using. You can use the commands on the View 
menu to change the viewing scale to anything between 25% and 800%. The 
blinking insertion point should be in the slot under the square root sign, 
indicating that whatever you enter next will appear there. 

Fraction Template 
As you hold the mouse 
pointer over the palette 
items their name is 
displayed in the status 
bar at the bottom of the 
MathType window. This 
will help you make sure 
you pick the correct 
template. 

5. Next, we enter a fraction template. To do this, go to the  palette and 
choose the  template — it’s the one on the right in the top row. This template 
produces reduced-size fractions, sometimes known as “case” fractions in the 
typesetting world. Case fractions are generally used to save space when the 
numerator and denominator of the fraction are just plain numbers. Be careful not 
to choose the larger  template — this would create a full-size fraction, which 
would be too big for this situation. Notice how MathType automatically expands 
the size of the square root sign to accommodate the fraction. Your equation 
should now look like this: 

  

The insertion point should be in the numerator (upper) slot of the fraction 
template. 

6. To enter the numerator of the fraction, just type 3. 

7. Now we need to move the insertion point down into the denominator slot of 
the fraction. You can do this by pressing the TAB key or by clicking inside the 
denominator slot in your equation. 

8. Enter the denominator by typing 16. 

9. Next we need to add the sin x outside of the square root sign, and to do this 
we have to get the insertion point into the correct position in the hierarchy of 
slots that make up the equation. If you repeatedly press the TAB key, you can 

23

     
 



MathType User Manual 

    
 

 

     
     

make the insertion point cycle through all the slots in the formula. If you hold 
down the SHIFT key while you do this, the insertion point will cycle through the 
slots in the reverse direction. Try this out to see how it works. Three of the 
positions that the insertion point will assume during the course of this cycling 
are shown below. Use a viewing scale of 400% or 800%, so that you can see 
what’s happening a little better: 

  

If you use the Show Nesting command on the View menu, you can get an even 
better picture of the hierarchical arrangement of slots in your equation: 

   

We have to decide which of these insertion point positions is the right one for 
adding the sin x. The position on the left is clearly wrong — we don’t want the 
sin x to go in the denominator of the fraction. In the position shown in the center, 
the insertion point is in the main slot under the square root sign, so if we type in 
sin x the result will be the following formula: 

  

This is not what we want either. The insertion point position shown on the far 
right is the correct one; the insertion point is outside the square root, which is 
where we want the sin x to go. 

Functions 
You can customize the 
list of functions that 
MathType automatically 
recognizes. Tutorial 4 
contains an example. 

10. Keep pressing the Tab key until the insertion point arrives in the correct 
position, and then type in the letters sinx. Type slowly, so that you can watch 
what happens. When you initially type them, the s and the i will be italic, 
because MathType assumes that they are variables. However, as soon as you 
type the n, MathType recognizes that sin is an abbreviation for the sine function. 
Following standard typesetting rules, MathType uses plain Roman (non-italic) 
format for the sin, and inserts a thin space (one sixth of an em) between the sin 
and the x. 
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11. Type –c. Remember you don’t have to type the spaces. You insert the minus 
sign by pressing the − (minus/hyphen) key on your keyboard. In a word 
processor, pressing this key inserts a hyphen, which is typically shorter than a 
minus sign. However, since hyphens are very uncommon in mathematics, 
MathType replaces them by minus signs for you (when the Math style is in 
effect). Your equation should now look like this: 

  

Keyboard Shortcuts 
You can also create a 
superscript slot by 
typing CTRL+H. CTRL+L 
inserts a subscript slot. 

Greek Characters 
You can enter a Greek 
character using CTRL+G 
and its eqivalent, e.g. m 
for µ, P for Π. 

Keyboard Shortcut 
The quickest way to 
close the MathType 
window is by pressing 
CTRL+F4. 

12. Next we need to attach the superscript (or exponent) to the c. To do this, 
click on the  icon in the Small Bar. This will create a superscript slot next to the 
c, as shown below:  

  

13. Type 2, and then press TAB to move the insertion point out of the superscript 
slot, into the position shown below: 

  

14. Click on the ± in the Small Bar. MathType knows that the ± symbol is 
supposed to have spaces around it in this situation, so, as usual, you don’t have 
to type them. 

15. Choose the µ from the  palette — it’s the second one from the right in 
the row of Symbol Palettes. Alternatively, as the Greek letter µ corresponds to 
the letter m, you can press CTRL+G, followed by m. Your equation should look 
like this: 

  

16. Finish the formula by typing tanx. Again, notice that MathType uses plain 
(instead of italic) type for the tan function and puts thin spaces on either side of 
it. Your finished equation should look like this: 

  

17.  Close the MathType window, either by clicking on its close box or by 
choosing the Close and return to <document> command on the File menu, and 
choose Yes in response to the dialog that asks if you want to save changes. This 
will insert your equation into the Word document in “displayed” form (on a line 
by itself), like this 

 23
16 sin tany x c µ= − ± x  
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18. In other situations, you might want to embed an equation within a line of 
text, for example µ= − ±23

16 sin tan ,y x c x rather than displaying it on a line by 
itself. To do this, use the Insert Inline Equation command from Word’s 
MathType menu or MathType toolbar. 

Tutorial 2: Sums, Subscripts & Superscripts 
In this tutorial we’ll create the formula that is often used to calculate a statistical 
quantity known as variance. The formula is: 

 2 2

1

1 n

X i
i

2X nX
n

σ
=

 
= − 

 
∑  

This formula illustrates the use of subscripts, superscripts, and summation 
templates. Integral and product templates behave much the same as summation 
templates, so what you learn in this tutorial will be useful in a variety of other 
situations. The steps required to create the formula are as follows: 

1. Open a new Word document, and type a few lines of text. 

2. Choose the Insert Display Equation command from Word’s MathType menu 
or MathType toolbar. This will open a MathType window, ready for you to start 
creating the equation.  

3. Enter a σ. One way to do this is to choose it from the  palette. 
Alternatively, you could use its keyboard shortcut. The keyboard shortcuts for 
toolbar items are displayed in the status bar as you move the mouse over them. 
In this case you can press CTRL+G followed by s. 

Zoom Levels 
A quick way to change 
zoom level is to right-
click in the Zoom panel 
on the status bar.  
Or, you can type: 
CTRL+1 for 100%, 
CTRL+2 for 200%, 
CTRL+4 for 400%, or 
CTRL+8 for 800%. 

4. Next, create slots for the subscript and superscript on the σ by clicking on 
the  icon in the Small Bar. Subscripts and superscripts are rather small. In 
order to better see what’s happening, make sure you’ve chosen at least 200% 
viewing scale in the Zoom submenu of the View menu.  

5. The insertion point will be located in the newly created subscript slot. Type 
the subscript, X. 

6. Move the insertion point up into the superscript slot either by clicking in it 
or by pressing the TAB key. Then type the number 2 into the superscript slot. 

7. Now let’s move the insertion point to the location shown below: 

  

Either press the TAB key, or click somewhere out to the right of the equation, as 
shown in the picture. Be careful not to place the pointer too close to the subscript 
or superscript slots, or else the insertion point may jump into one of them when 
you click.  
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8. Type in the = sign. Remember not to type any spaces. 

9. Construct the fraction by using the full-size  template, which is available 
in the Small Bar and in the  palette. Be careful — it’s not the same 
template as the  fraction template that we used in Tutorial 1. 

Inserting Fractions 
You can also insert the 
fraction template by 
pressing CTRL+F. 

Spacing 
Chapter 7 includes a 
discussion of 
MathType’s spacing 
rules and how you can 
customize them. 

10. The insertion point will be located in the newly created numerator slot; type 
the number 1 into this slot. 

11. Move the insertion point down into the denominator slot either by clicking 
in it or by pressing the TAB key. Then type in the denominator, n, and press the 
TAB key again to move the insertion point out of the denominator slot. Your 
equation should now look like this: 

  

12. Next we need to insert a pair of braces (curly brackets). You can do this 
either by clicking on the  icon in the palette, or by using the CTRL+{ keyboard 
shortcut. Remember that { is a shifted character on standard keyboards, so you’ll 
actually need to hold down the CTRL and SHIFT keys while pressing the key that 
bears the [ and { characters. 

13. Click on the  icon to enter a summation template inside the braces. Notice 
how the braces expand automatically. Your equation should now look like this: 

  

14. Type the letter X into the summand slot (the large slot on the right). 

15. Attach a subscript and superscript to the X, using the  template. Fill in the 
subscript and superscript slots with i and 2, respectively. 

16. Move the insertion point into the lower limit slot of the summation template 
by clicking inside the slot, and type i=1. As usual, do not type any spaces. 
MathType will automatically reduce the size of the text, and will center it below 
the summation sign. In this case, MathType will not insert any spaces around the 
= sign, since it is in the limit of a summation. Again, this is a standard 
typesetting convention that you can override if you want to. 

17. Click in the upper limit slot of the summation template, and type in the 
upper limit, n. 
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18. Move the insertion point into the position shown below: 

  

If the insertion point is in the upper limit slot of the summation template, 
pressing the TAB key will do the trick. In fact, as we saw in Tutorial 1, if you keep 
pressing the TAB key, the insertion point will cycle through all the slots in the 
equation and will eventually reach the position shown, regardless of where it 
started out. If you want to move the insertion point by clicking, click somewhere 
near the point indicated by the arrow in the picture above. You might want to 
use the Show Nesting command on the View menu to make this easier. 

19. Type –nX. 

20. Place a bar over the X by clicking on the  icon in the  palette. In 
MathType, embellishments of this type are always added to the character to the 
left of the insertion point. You can even add several embellishments to the same 
character. For more details, look for Embellishments in MathType’s online help. 

21. Enter the superscript 2 by using the  template. It works just the same way 
as the  template that we used earlier. The equation is now complete (well, 
maybe it is — see the next step below). 

22. We hope you’re happy with the way MathType formats your equation, but, 
if you’re not, we’ve provided a way for you to make some fine adjustments of 
your own. You can select any item or group of items, in the usual way, and 
nudge them either horizontally or vertically in steps of one pixel (screen dot). If 
you view your equation at 800% scale you can make adjustments as small as an 
eighth of a point. 

To nudge items, use the following keystrokes: 

 CTRL+←  nudges the selected items to the left by one pixel  
CTRL+↑  nudges the selected items upward by one pixel 
CTRL+→  nudges the selected items to the right by one pixel  
CTRL+↓  nudges the selected items downward by one pixel 

Selecting an 
Embellishment 
You can select an 
embellishment by 
holding down the CTRL 
key and then clicking on 
the embellishment. 

You might want to try moving a subscript or a superscript, moving the limits of 
the summation, or even moving the bar embellishment. 

Keep in mind, however, that nudging is really intended for making small 
adjustments that cannot be achieved otherwise. The preferred method for 
adjusting spacing is using the Define Spacing dialog, described in Chapter 7. 
This approach has the advantage that the spacing rules you define affect all 
equations. 
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23. Close the MathType window, which will insert the equation into your Word 
document. Save the document, because we’re going to use it in the next tutorial. 

Tutorial 3: Editing Old Equations 
This tutorial teaches you some special editing techniques that are useful when 
you’re modifying an existing equation. You will often need to correct a mistake 
in an old equation, or make a new one that is a slight variation of one that you 
have made in the past. Instead of starting from scratch, you can bring a copy of 
the old equation back into MathType and modify it as needed. In this way, all 
your old documents serve as sources of material for new documents. You can 
store commonly used equations (or fragments of equations) in word processing 
documents or as expressions within MathType itself. 

Let’s suppose that the equation we created in Tutorial 2 is the wrong one, and we 
want to use the following related formula in our document instead: 

 2 2

1

1
1

n

X i
i

s X nX
n =

 
= − −  

∑  

The steps required are as follows: 

1. Open the Word document containing the equation you created in Tutorial 2 
above. We want to bring this equation back into MathType for editing. There are 
several ways to do this, as explained in Chapter 5, but the simplest is to double-
click on it. This will open the equation for editing, in a new MathType window. 

2. Select the term on the left-hand side of the equation by dragging the arrow 
pointer across it while holding down the left mouse button. The selected items 
will be highlighted by black-white reversal, in the usual Windows manner. It 
should look like this: 

  

3. Delete the selected items by using the Clear command on the Edit menu, or 
by pressing the BACKSPACE key or the DELETE key. 

4. The insertion point is in the right place, immediately to the left of the = sign, 
so you can now enter the new left-hand side. Type in the letter s and attach the X 
subscript to it by using the  template, in the usual way. 

5. Next, we’re going to enclose the right-hand side in a square root sign. We’re 
going to “wrap” a  template around the existing terms — previously we have 
always inserted templates first, and then filled in their slots afterwards. Select 
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the entire right-hand side of the equation, watching the highlighting carefully to 
see that your selection is correct. It should look like this: 

  

MathType 3 Users 
MathType 3 required 
you to hold down the 
CTRL key to wrap a 
template around the 
selection. This is no 
longer necessary. 

Color 
You can customize the 
Color menu using the 
Edit Color Menu 
command in the Color 
submenu. 

Now click on the  icon in the Small Bar. The  template will be inserted into 
your equation and automatically wrapped around the selected items. When you 
insert a template, MathType always wraps it around any selected items.  

6. You might be wondering how you would do the reverse of the operation we 
performed in step 5 — suppose you had an expression enclosed in a square root 
sign (or some other template) and you wanted to remove the square root sign but 
keep the expression. To do this, you first select the expression under the square 
root sign and choose Cut to transfer it to the Clipboard. Next, select the (now 
empty) square root sign, and press BACKSPACE or DELETE to remove it. Finally, 
choose Paste to bring the expression back from the Clipboard. 

7. Finally, we have to change the n in the denominator of the fraction to n – 1. 
Position the insertion point in the denominator slot, to the right of the n, by 
clicking near the point indicated by the arrow pointer in the picture below: 

  

Then, simply type –1 to change the denominator. 

8. Let’s now suppose we want to change the color of the term from black to 
red. Select the term using the mouse, and then choose the Color command on the 
Format menu. A submenu appears containing a list of colors. Choose Red and 
release the mouse. The selected term will become red (you will have to click 
outside the equation to de-select the term in order to see the new color).  

Xs

9. We’re finished editing the equation, so close the MathType window. If a 
dialog appears asking if you want to save your changes, click Yes. Once the 
MathType window has closed, your word processor will become active and 
you’ll see that your document now contains the modified equation. 
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Tutorial 4: Including Text in an Equation 
In our next tutorial, we show you how to enter words and phrases in an 
equation, and also how to handle function name abbreviations that MathType 
does not recognize. We are going to create the following equation: 

 Prob( ) Probability that   and  occurProb( | )
Prob( ) Probability that  occurs

A B A BA B
B B
∩

= =
both  

1. First, open a new MathType window using one of the methods you’ve 
already learned. Then type Prob(A|B). The result will be  

  

Controlling Italics 
To assign regular (non-
italic) style to function 
names, use Function on 
the Style menu, rather 
than just removing the 
italics. 

Copying and Dragging 
To re-use part of an 
existing equation, select 
the part and then use 
the Copy and Paste 
commands, or drag and 
drop. Hold down the 
Control key when 
dragging to copy the 
selection. 

Typing Text 
Before typing normal 
words and phrases, 
choose Text from the 
Style menu. 

Using its built-in table of function names, MathType has recognized Pr as an 
abbreviation for “probability” and set it in the Function style, while o and b are 
regarded as variables. In this tutorial, we want to use Prob, rather than just Pr, as 
our abbreviation for “probability”. You might think that you can fix the problem 
by just making the o and b non-italic, but we don't recommend this. If you 
simply remove the italicization, MathType will still regard o and b as variables, 
which is not what we intend. The right approach is to select Prob and choose 
Function from the Style menu. This will remove the italics, but it also tells 
MathType that Prob is the name of a function, which will affect spacing and 
translation into languages such as ATEXL  and MathML. 

2. Create the fraction in the middle term of the equation. You can copy and 
paste Prob(A|B), and modify it for re-use in the numerator and denominator. 
You can find ∩, the set intersection symbol, on the  palette. Your equation 
should now look like 

  

3. Construct the fraction on the right-hand side of the equation by using the  
template again. The insertion point will be positioned in the numerator, ready to 
type the text. 

4. If you just start typing characters into the numerator slot, MathType will 
assume that they are variables, so they will be italicized, and any spaces you type 
will be ignored. To type ordinary words and phrases, you should first choose 
Text from the Style menu. Then type Probability that both A and B occur. The 
numerator of our fraction will look like this: 

  

This is what we want, except that the word “both” should be bold and the A and 
B should be italic.  
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